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Support and other contacts

United States and Canada

Contact Honeywell IAC Solution Support Center

Phone 1-800 822-7673. In Arizona: (602) 313-5558
Calls are answered by dispatcher between 6:00 am and 4:00 pm Mountain
Standard Time. Emergency calls outside normal working hours are
received by an answering service and returned within one hour.

Facsimile (602) 313-5476

Mail Honeywell IS TAC, MS P13
2500 West Union Hills Drive
Phoenix, AZ, 85027

Europe

Contact Honeywell TAC-EMEA

Phone +32-2-728-2704

Facsimile +32-2-728-2696

Mail Honeywell TAC-EMEA
Avenue du Bourget, 1
B-1140 Brussels, Belgium

Pacific

Contact Honeywell Global TAC - Pacific

Phone 1300-300-4822 (toll free within Australia)
+61-8-9362-9559 (outside Australia)

Facsimile +61-8-9362-9169

Mail Honeywell Global TAC - Pacific
5 Kitchener Way
Burswood, WA, 6100, Australia

Email GTAC@honeywell.com
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India

Contact Honeywell Global TAC - India
Phone +91-20-2682-2458 / 1600-44-5152
Facsimile +91-20-2687-8369

Mail Honeywell Automation India Ltd.
56 & 57, Hadapsar Industrial Estate
Hadapsar, Pune -411 013, India

Email Global-TAC-India@honeywell.com
Korea

Contact Honeywell Global TAC - Korea
Phone +82-2-799-6317

Facsimile +82-2-792-9015

Mail Honeywell Korea,
17F, Kikje Center B/D,
191, Hangangro-2Ga
Yongsan-gu, Seoul, 140-702, Korea

Email Global-TAC-Korea@honeywell.com

People’s Republic of China

Contact Honeywell Global TAC - China
Phone +86-10-8458-3280 ext. 361
Mail Honeywell Tianjin Limited

17 B/F Eagle Plaza

26 Xiaoyhun Road

Chaoyang District
Beijing 100016, People's Republic of China

Email Global-TAC-China@honeywell.com
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Singapore

Contact Honeywell Global TAC - South East Asia
Phone +65-6580-3500

Facsimile +65-6580-3501
+65-6445-3033

Mail Honeywell Private Limited
Honeywell Building
17, Changi Business Park Central 1
Singapore 486073
Email GTAC-SEA@honeywell.com
Taiwan
Contact Honeywell Global TAC - Taiwan
Phone +886-7-323-5900

Facsimile +886-7-323-5895
+886-7-322-6915

Mail Honeywell Taiwan Ltd.
10F-2/366, Po Ai First Rd.
Kaohsiung, Taiwan, ROC

Email Global-TAC-Taiwan@honeywell.com
Japan

Contact Honeywell Global TAC - Japan
Phone +81-3-5440-1303

Facsimile +81-3-5440-1430

Mail Honeywell K.K

1-14-6 Shibaura Minato-Ku
Tokyo 105-0023
Japan

Email Global-TAC-JapanJA25@honeywell.com

Elsewhere

Call your nearest Honeywell office.

World Wide Web
To access Honeywell Solution Support Online, do the following:

1 In your web browser, type the address http://www.honeywel1.com/ps.
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2 Click Login to My Account and then log on.

3 Move the pointer over Contacts & Support in the top menu bar and then
choose Support from the popup menu.

Training classes

Honeywell holds technical training classes on Experion. These classes are taught
by experts in the field of process control systems. For more information about
these classes, contact your Honeywell representative, or see http://
www.automationcollege.com.

Related documentation

For a complete list of publications and documents for Experion, see the Experion
Overview.
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About this guide

This guide describes how to write applications for Experion, Release 300.

To write applications using the: Go to:
API page 17
Network API page 323
Object Models page 431
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API reference

This section describes how to write applications for Experion using the API.

For: Go to:
Prerequisites page 18
An introduction to the development environment page 19
An introduction to the types of applications you can develop: fasks and page 33
utilities

Information about integrating your application with Experion page 43
A description of the Experion database, and how you access data page 65
Information about writing applications for Station page 99
Information about writing interfaces for unsupported controllers (user scan |page 105
tasks)

Development utilities page 115
C application library page 127
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2 — API REFERENCE

Prerequisites

Before writing applications for Experion, you need to:

» Install Experion and third-party software as described in the Installation
Guide.

* Be familiar with user access and file management as described in the
Configuration Guide.

Prerequisite skills

This guide assumes that you are an experienced programmer with a good
understanding of either C or C++.

It also assumes that you are familiar with the Microsoft Windows development
environment and know how to edit, compile and link applications.

18 www.honeywell.com/ps



About the development
environment

If development is to be conducted on a target system, consideration must be given
to the potential impact on the systems performance during the development.

Use of these facilities requires a high level of expertise in the development tools,
including C compiler, C++ compiler, linker, make files and batch files.
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3 — ABOUT THE DEVELOPMENT ENVIRONMENT

Folder structures

The structure shown below should be used for development of applications which
will run on the server.

The user\xxxx\src folder contains all source code files and make files for a
particular application. xxxx should be representative of the function of the
application.

The include and include\src folders contain global server definitions, such as
system constants or data arrays in the form of C/C++ include files.

The run folder contains all server programs (including applications). This folder
is included in the path of any server user.

The data folder contains all server database files.

<server directory>
|

user diaf include run data
XXXX SIc SIC
src

20 www.honeywell.com/ps



COMPILING, LINKING AND EDITING

Compiling, linking and editing

((!))

The supported compilers for developing applications are:
* C—Microsoft Visual C/C++ Version 6.0 SP5 and Version 7.1
* C++—Microsoft Visual C/C++ Version 6.0 SP5 and Version 7.1

For whichever language you use, the appropriate application should be installed
and the environment variables set up.

When compiling C/C++ application programs you need to have the Microsoft
Windows Platform SDK installed using the August 2001 version or later. The
latest SDK 1is available from Microsoft at http://www.microsoft.com/
msdownTload/platformsdk/sdkupdate/.

The SDK’s include and lib directories need to be the first directories listed in the
include and library paths.
Considerations

* Complete this procedure only if you have Microsoft Visual C/C++ Version 6.0
SPS.

Attention

Whenever you upgrade to a new release of the server you need to recompile your
server applications.

To modify the paths (after having installed the SDK):

1 In the Microsoft Visual Studio application window, choose Tools > Options.
The Options dialog box opens.

2 Click the Directories tab.
3  From Show directories for, select Include files.

4 Addc:\program Files\Microsoft SDk\include as the first entry, as shown
in the following figure.
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3 — ABOUT THE DEVELOPMENT ENVIRONMENT

2l
Editor | Tabs | Debug I Compatibility I Build ‘ Diirectories | z EE

Blatfarm: Show dieclaries for:
[winaz =1 [include fies |

|Qir=:t:m=s . U A 2

include

":4Program Files f e
C:MProgram Files'Honepwell\E xperion PK.S\serversnclude
C:AProgram FileshMicrosoft Visual StudioWWCIBMMCLUDE
C:MProgram FileshMicrosoft Visual StudioWCI8\MFCAMCLLUDE
C:MPragram FilashMicrosaft Visusl Studis\WCABWATLMNCLUDE

Cancel I

5 From Show directories for, select Library files.

6 Add c:\Program Files\Microsoft SDK\1ib as the first entry, as shown in
the following figure.

2
E ditar | Tabs | Debug I Compatibility I Buid  Direstories | z EE

Platform: Shaw direcloriss for:
|W|n32 j ILbrary files j

b

T+ +

C:AProgram Files\HONE T ELLME wperion PKS\Servertlib
C:MPragram FilesiMicraseft Visual StudiaWWCIEALIE
C:AProgram FileshMicrosoft Visual StudioWWCIB\MFCALIB

Cancel I

7 Click OK to save your changes and close the dialog box.

Editing of source files can be achieved using any of the editors that come with
Windows 2003 (for example, Notepad) or the programs listed above.

When creating source files, it is important to remember that they must be in the
src folder, under your application folder. C source files have a “.c” suffix and
C++ source files have a “.cpp” suffix.

In order for the applications to have access to the server database, the Windows
account under which they run must belong to the Honeywe11 Administrators
Windows group.
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USING MICROSOFT VISUAL STUDIO

Using Microsoft Visual Studio

To use Microsoft Visual Studio to develop applications in C or C++, you first
need to set up Visual Studio.

Honeywell 23



3 — ABOUT THE DEVELOPMENT ENVIRONMENT

Setting up Microsoft Visual Studio

Setting up Microsoft Visual Studio involves:

Modifying the Tibrary and include paths to include the Experion folders.
Creating a project workspace.

Defining the project settings for Experion application development.

Considerations

If Experion is not installed in c:\Program Files\Honeywell\Experion PKS\
server, change the paths used in steps 4 and 6 to reflect where it is installed.

Setting up Microsoft Visual Studio Version 6 SP5

To modify the paths:

1 In the Microsoft Visual Studio application window, choose Tools > Options.
The Options dialog box opens.

2 Click the Directories tab.

3 From Show directories for, select Include files.

4 Addc:\Program Files\Honeywell\Experion PKkS\server\include to the
include file folders.

5 From Show directories for, select Include files.

6 Addc:\Program Files\Honeywell\Experion PKS\server\1ib to the
Tibrary file folders.

7 Click OK to save your changes and close the dialog.

To create a project workspace in Visual Studio version 6:

1

In the Microsoft Visual Studio application window, from the File > New
menu, select the Projects tab.

Select the Type of project you are developing (Win 32 Console Application,
MFC AppWizard (exe), and so on).

Complete the project details and click OK to create the project and close the
dialog box.

To define the project settings:

1

2

Choose Project > Settings.
The Project Settings dialog box opens.

Click the C/C++ tab to display the C/C++ property sheet.

24 www.honeywell.com/ps
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USING MICROSOFT VISUAL STUDIO

From the Category list, select General.
Add NT to the Preprocessor Definitions.
From the Category list, select Code Generation.

From the Use run-time library list, select Multithreaded DLL.

For debugging, use Debug Multithreaded DLL. Use Multithreaded DLL
only for release compiles. If you use the incorrect library for a debug compile,
errno does not propagate correctly (it will be always zero).

Click the Link tab to display the Link property sheet.
From the Category list, select General.

In the Object/library modules box add hscsrvapi.lib.

For debugging, use hscsrvapid.lib. Use library hscsrvapi.1ib only for
release compiles. If you use the incorrect library for a debug compile, errno
does not propagate correctly (it will be always zero).

Ensure that the Ignore all default libraries check box is cleared.

If you are developing an MFC application and want to dynamically link to
MEFC:

a. Click the General tab, and from the Microsoft Foundation Classes list
select Use MFC in a Shared Library.

b. Select Input from the Category list and ensure that msvcrt is not in the
Ignore Libraries text box.

If you are developing an MFC application and want to statically link to MFC:

a. Click the General tab, and from the Microsoft Foundation Classes list
select Use MFC in a Static Library.

b. Select Input from the Category list and add msvcrt to the Ignore
Libraries text box.

Click OK to save your project settings and close the dialog box.

Setting up Microsoft Visual Studio Version 7.1

To modify the paths:

1 In the Microsoft Visual Studio application window, choose Tools > Options.
The Options dialog box opens.

2 In the tree view expand the Projects folder and click VC++ Directories.

3  From Show directories for, select Include files.

4 Addc:\Program Files\Honeywell\Experion PKS\server\include to the

incTude file folders.
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3 — ABOUT THE DEVELOPMENT ENVIRONMENT

26

7

From Show directories for, select Library files.

Add c:\Program Files\Honeywell\Experion PKS\server\1ib to the
Tibrary file folders.

Click OK to save your changes and close the dialog.

To create a project workspace in Visual Studio .Net 2003:

1

In the Microsoft Visual Studio application window, from the File > New
menu, select the Projects tab.

Select the Type of project you are developing (Win 32 Console Application,
MFC AppWizard (exe), and so on).

Complete the project details and click OK to create the project and close the
dialog box.

To define the project settings:

1

oo g AW DN

Choose Project > Projectname Properties where Projectname is the name of
your project.

The Property Pages dialog box opens

In the tree view click the C/C++ folder to display the C/C++ property sheet.
From the C/C++ list, select Preprocessor.

Add NT to the Preprocessor Definitions.

From the C/C++ list, select Code Generation.

From the Runtime library list, select Multithreaded DLL.

For debugging, use Debug Multithreaded DLL. Use Multithreaded DLL
only for release compiles. If you use the incorrect library for a debug compile,
errno does not propagate correctly (it will be always zero).

In the tree view click the Linker folder to display the Link property sheet.
From the Linker list, select Input.

In the Additional Dependencies box add hscsrvapi.lib.

For debugging, use hscsrvapid.lib. Use library hscsrvapi.1ib only for
release compiles. If you use the incorrect library for a debug compile, errno
does not propagate correctly (it will be always zero).

10 Ensure that Ignore all default libraries is set to No.
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USING MICROSOFT VISUAL STUDIO

11 If you are developing an MFC application and want to dynamically link to
MEFC:

a. In the tree view under Configuration Properties click General, and from
the Use of MFC list select Use MFC in a Shared Library.

b. In the tree view, expand the Linker folder and click Input. Ensure that
msvcrt is not in the Ignore Libraries box.

12 If you are developing an MFC application and want to statically link to MFC:

a. In the tree view under Configuration Properties click General, and from
the Use of MFC list select Use MFC in a Static Library.

b. In the tree view, expand the Linker folder and click Input. Add msvcrt to
the Ignore Libraries box.

13 Click OK to save your project settings and close the dialog box.
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3 — ABOUT THE DEVELOPMENT ENVIRONMENT

Compiling and linking C and C++ projects using Visual Studio

To compile and link your project in Microsoft Visual Studio, select Build Build
<project name>.

0 Attention
(®

This procedure will only work with C and C++ projects. After compiling and linking, all
executable files should be copied to the run folder.
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Error codes in the API

Error status information is returned from functions in the API using one of two
different methods. The first method is used by most of the C functions in the
server API. These functions return FALSE (0) if they were completely successful,
otherwise they return TRUE (-1).

If TRUE (-1) is returned, errno will be set to the return status of the function.
This value can be checked to see whether it indicates an error or a warning using
the functions hsc_Iserror() and hsc_tswarning(). To safely retrieve the value
of errno, call the function c_geterrno(). Any applications which use this
function should include the M4_err_def file, that is, #include “src\mM4_err_
def”. The following example shows how to check the error status.
if (c_server_api_function(argl, arg2) == -1)
{
if (hsc_IsError(c_geterrno()))
{
// real error occurred
}
else
{
// only a warning has been issued
// safe to ignore

}
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Network API applications fail to run

If you have developed a NetAPI application and try to run it on a node that
doesn’t have Experion NetAPI installed, the application will fail to run. The
hscnetapi.dll that is shipped with Experion NetAPI is required for all NetAPI
applications to run on an Experion server.

To resolve this problem, copy the file c:\windows\System32\hscnetapi.d11
from a node that has the Experion NetAPI installed and copy it into the same
directory on the computer that doesn’t have Experion NetAPI installed and needs
to run the application.
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Debugging utilities and tasks

Before a utility or task can be debugged, it needs to be compiled and linked with
debugging information.

To compile and link with debugging information for C/C++ applications using
Visual Studio, select the Debug build as the active configuration. To do this,
select Build Configuration Manager and then select the debug build.

To set up the debugging utilities:

1 Open the project using Visual Studio.

2 Open up the source files for the utility. In the case of a C/C++ program, the
filenames will not have been altered.

3 Set break points as required in the source files.

4 Start the debugger (select Debug Go).

To set up the debugging tasks:
1 Run the server utility program DBG, passing it the LRN the task is using.
2 Complete the procedure described for debugging a utility.

3 Execute and ETR on the LRN. (For more information see “ETR” on
page 120.)

4 Debug the program.

0 Attention

(©) . . L

When using the DBG utility, make sure that no other application executes a gbload()
before your application, otherwise it will be assigned the LRN you specified in step 1.

Disabling the default debugger (Dr Watson)

By default, every time the server starts it sets Dr Watson as the default debugger.

You can prevent the server doing this (which allows you to use another debugger
such as Visual Studio) by updating the registry as follows: go to the registry key
HKEY_LOCAL_MACHINE\Software\Honeywel1l, and create a string value called
Enablebebug. (You do not have to specify a value.)
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Multithreading restrictions

Multithreading is a form of multi-tasking which allows an application to
multitask within itself. It is possible to write a multithreaded application that uses
the application programming library but it is not recommended.

If there is a requirement for multithreading then the following should be
observed:

* Call c_gbload before any threads are created.

» Keep all access to the application programming library serialized. This can be
achieved in two ways. Keep all calls to the application programming library in
one thread (for example, the main thread of the program) or encase any calls
in a critical section. See the code fragment below for an example.

Example // Main code segment

CRITICAL_SECTION SserAPI; /*critical section for calling the
Server APIs */

InitializeCriticalSection(&serAPI);

if (c_gbload())

{
/* Could not attach to database */
exit(-1);

. Create threads
... Execution continues on
//End of main code segment

// Thread code segment

EntercCriticalSection(&seraArPI);
. Call to Experion API

LeaveCriticalSection(&serAprPI);
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4 — IMPLEMENTING A SERVER APPLICATION

Application choices

Before you can implement an application you will need to make a choice on the
programming language you will use and the type of application you are going to
implement.

Programming languages

The Application Programming Library supports the development of C/C++
applications.

The language you choose to use will largely depend on your experience with
these languages. Alternatively, it is possible to develop an OPC Client to access
server data via the Experion OPC Server. The client can be written in C or C/++.

Type of application

There are two types of application you can develop:

Utility. A utility runs interactively from the command line using a command
prompt window. (A command prompt is opened by choosing Start >
Programs > Accessories > Command Prompt.)

Utilities typically perform an administrative function or a function that is
performed occasionally.

A utility can prompt the user for more information and can display
information directly to the user via the command prompt window.

An example of a utility is an application to dump the contents of a database
file to the command prompt window, for example FILDMP.

Task. Tasks are usually dormant, waiting for a request to perform some form
of function. When they are activated, they perform the function and then go
back to sleep to wait for the next request to come along.

An example of a task is an application that periodically fetches some point
values, performs a calculation on the values and stores the result back in the
database.
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C/C++ application template

This section provides a generic C/C++ application template that can be used for
any application you may develop. Again, it doesn’t contain much functionality
but it should give you an idea of the parts necessary for an application.

Definitions

A C/C++ application also needs to contain several include files that declare and
define items used by the application programming library routines. These include
files should be incorporated in the main source file as well as any function source

files that make calls to the application programming library routines. The include
files used by this template are:

Include file Description

defs.h Defines system constants and some useful macros.
files Defines all the logical file numbers of the database.
parameters Defines all the point parameters of a point.
GBtrbtb1.h Defines the structure of one of the database files.

The include folder also contains many other GBxxxxxx. h include files that may be
needed if you make calls to other application programming library routines.
#include <src\defs.h>
#include <files>
#include <parameters>
#include <src\GBtrbtbl.h>
char *progname="myapp.c”’;

main(Q)

{

uint2 ierr;

char string[80];
struct prm prmblk;

Initialization

The first function you must call in any application is GBLOAD. This function
makes the global common memory available to the application, allowing it to
accesses the memory-resident part of the database. If this call fails you should

terminate the program. This function should only be called once for the whole
program.
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if (ierr=c_gbload())

{
//The next Tine number 1is 137
c_logmsg(progname, “137”, “Common Load Error %d\n”, ierr);

c_deltsk(-1);
c_trmtsk(ierr);

}

Main body of a utility

This is where the majority of the work of the application is done. If your
application requires arguments from the command line, you can call GETPAR to
retrieve individual arguments. You can also use the argv and argc parameters if
your utility has a C/C++ main function.

As the application is run interactively you can print messages to the command
prompt window using the printf command and also scan messages back from the
command prompt window using the scanf command. A C++ application can use
std::cin and std::cout.

After the application has completed its work you should call DELTSK and
TRMTSK to mark the application for deletion and to terminate the application. It
is your responsibility to close any files you may have opened in the application.

c_getpar(l,string,sizeof(string))

#%%% parform some Function *¥¥*

printf(“Results of Function\n”);

c_deltsk(-1);

c_trmtsk(0);

}

Main body of a task

36

The main body of a task is slightly different in that it is usually all contained in an
endless loop. After the task is started, it will remain in this loop until the system is
shut down.

As the application is not run interactively, you cannot “scanf” responses from a
command prompt window. You can use the c_Tlogmsg function to write messages
and information to the log file. The log file can be viewed by looking at the file
server\data\log.txt with Notepad or the tail utility.

After the task enters the endless loop, it should call GETREQ to see if any other
application has requested it to perform some function. The call to GETREQ will
return a parameter block that provides information about who and why the task
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was requested. Based on this information, the task should perform the desired
function, loop back up and check for the next request.

If no request is outstanding, the task should call TRM04 to cause it to go to sleep.
This will cause the task to block (or hibernate) until the next request.

When the next request comes along, the task:

1 Returns from the TRMO04 call.

Loops back up.

Gets the parameter block associated with the request.

Performs the function.

[, IR — R Y I

Continues.
while (1)
{
if (c_getreq((int2 *) &prmbl1k))
{
if (errno != M4_EOF_ERR)

{
/* it is a real error so report and */
/* handle it */

}

/* Now terminate and wait for the */

/* next request */

c_trm04 (ZERO_STATUS) ;

}

else

{

/* pPerform some function */
}
b

The c_getreq function will return a FALSE (0) if there is has been a request. It
will return the error M4 _EOF_ERR (0x21f) if there are no requests pending. If
any other error is returned, then this should be reported and optionally handled.

In the definitions section, you may have noticed the use of the C/C++ data type
“uint2”. This is one of several data types that are defined in the header file
defs.h. This is necessary because different C and C++ compilers define the
different sizes for: int, long, float, and double.

The following data types are used throughout the application programming
library routines:
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Data type Description

int2 Equivalent to INTEGER*2
uint2 Unsigned version of int2
int4 Equivalent to INTEGER*4
uint4 Unsigned version of int4

They are defined in the header file defs.h.

The defs.h file also provides several macros which should be used whenever the
user wants to access int4, double or real database values, including user table
values of these types. The available macros are:

Macro Description

1dint4(int2_ptr) Load an int4 value from the database (pointed to by
int2_ptr).

stint4(int2_ptr, int4_val) Store an int4 value in the database at the position pointed
to by int2_ptr.

ldreal(int2_ptr) Load a real value from the database.

streal(int2_ptr,real_val) Store a real value in the database.

lddble(int2_ptr) Load a double value from the database.

stdble(int2_ptr,dble val) Store a double value in the database.

These macros help to ensure that all types are properly assigned in C/C++
programs, to provide portability between different computer architectures.

One example of the use of such macros is provided below. This example shows
how a C program would assign a floating point value to a variable, and also how a
floating point value may be stored in the database.

#include <src\defs.h>

#include <src\GBsysflg.h>

float fvall;
float fval2;

/*1oad the seconds since midnight into the variable fvall */
fvall = ldreal(GBsysflg->syssec);

/* store the value of fval2 into the seconds since midnight */
streal (&GBsysflt->syssec, fval2);
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The other macros mentioned above are used in a similar manner. For the
definitions of these macros, consult the defs.h file.

Writing messages to the log file

((!))

When programming in C/C++ you should not use printf, fprintf calls or the
std::cout or std: : cerr streams to write messages to the log file. Instead the
API routine c_logmsg() should be used.

It has the prototype:
void c_Togmsg
(
char* progname, //(in) name of program module
char* Tineno, //(in) Tine number in program module
char* format, //Cin) printf type format of message
K
Instead of:

printf(“Point ABSTATO01 PV out of normal range
(%d)\n” abpv);
or
fprintf(stderr,“Point ABSTATO01 PV out of normal range
%6d)\n”,abpv) ;
or

std::cout <<“Point ABSTAT001 PV out of normal range”
<<abpv <<std::endl;

Use:

c_logmsg (“abproc.c”, “134”,
“Point ABSTAT001 PV out of normal range
(%d)”,abpv);

Attention

c_logmsg handles all carriage control. There is no need to put line feed characters in
calls to c_logmsg.

If c_Togmsg is used to write messages in a utility then the message will appear in
the command prompt window.
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Server redundancy

If your task follows the guidelines described in this document and only accesses
data from user tables and points, you do not have to do anything special for
redundancy. (Your task doesn’t need to determine which server is primary
because GBload only allows the task on the primary to run.)

On a redundant system the task is started on both servers. If the server is primary,
the task continues normal operation after GBLoad. However, if the server is
backup the task waits at GBLoad.

When the backup becomes primary, the task continues on from GBLoad. In the
meantime, what was the primary will reboot and restart as backup and the task
will wait at GBLoad.
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Developing an OPC client

Experion provides an OPC Server which enables OPC clients to access Experion
point data.

The Experion OPC Server supports two standard OPC interfaces—a custom
interface for use by clients written in C, and an automation interface for use by
clients written in Visual Basic. You can write an OPC client in either of these
languages.

For more information about:
» The Experion OPC Server, see the Configuration Guide.

¢ OPC interfaces, see the OPC Standard. This standard can be downloaded from
http://www.opcfoundation.org.
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Developing an ODBC client

Visual Basic or C++ applications can access the server database by using the
Experion ODBC driver.

For more information about writing an application that uses the Experion ODBC
driver, see the Configuration Guide.
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Starting an application

These topics describe how to start an application.
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Running a utility from the command line

After a utility has been compiled and linked, as described in “About the
development environment” on page 19, it is ready to be run from the command
line. The utility’s output should direct the user on what to do to use the utility.

Honeywell 45



5 — CONTROLLING THE EXECUTION OF A SERVER APPLICATION

Selecting an LRN for a task

Before you start a task, select a unique number to use to identify the task. This
number is called the Logical Resource Number (LRN) of the task.

Several LRNs are reserved by the server for internal use and should not be used
for applications. Use the USRLRN utility to determine a free application LRN
that can be allocated to your task.

To use USRLRN and select one of the numbers it displays, type:
usrirn

If there are no free application LRNs, search through the reserved LRNs for any
free numbers by typing:
usrirn -a

When a task is executing, you can identify its LRN by calling the library routine
GETLRN. This LRN is needed in some other library routines and it prevents you
from having to hard-code it into your source code.
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Starting a task automatically

d

You can configure your system to start your task automatically whenever the
server starts up. Your task will always be up and ready to be activated whenever
the server system is running.

Attention

Configuring the task to start automatically it only takes effect after you have stopped and
started the server. Also note that once the task is started, it needs to be activated before
any of its commands are executed.

To configure your task to start automatically:
1 Log on to Station with MNGR security level.

2 Choose Configure > Application Development > Application Summary to
call up the Applications Summary display.

3 Click an empty record line to call up the System Configuration—Application
display.

4 Type a suitable descriptive title in Description.

5 Type the name of the executable without the .exe extension in Task Name.
This is the name you use to link your application.

_—— System Configuration Application 1 Flow Calculator “

B General

E System Hardware
B Areas

ElAlarm & Event Management Description | Flow Calculator
B Operator Security

EHistory Task Hame
ElReports FLOWCALC
Hschedules

® Trend & Group Displays

Definition

Previous

i
g

-
@
@
=
jul
g

[x}

R NI " N TR VR

a
=

H Server Scripting

Database Resources
File numker 0 for [0 Shape number L] far |0
Page number [] for [0 Acronym numeer | 0 for [0

S
T deldddE

]

6 Type the LRN you have selected for your task in Task LRN. See “Selecting
an LRN for a task” on page 46.

7 Type 17 (the recommended priority for user tasks) in Task Priority.
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The Database Resources options are used to store further configuration
information about your application. The task may access this information by
using the GETAPP function.
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Starting a task manually

It can often be useful to start a task manually from the command line, either for
debugging purposes or because you do not have the opportunity to stop and start
the server to do it automatically. Several utilities are provided to allow you to
manipulate a task from the command line.

The syntax for starting a task is:
addtsk name Trn [priority]

Item Description

name The executable file name of your task.

1rn The LRN for the task, see “Selecting an LRN for a task” on
page 46.

priority The priority of task execution (use 0 as a default).

To activate a task from the command line use:
etr Irn

To mark a task for deletion from a command line use:
remtsk 7rn

where 7rnis the task’s LRN.
For details about these utilities, see ADDTSK, ETR and REMTSK.
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Activating a task

50

After a task has been started it is ready to receive requests to be activated. The
server can be configured to activate your task whenever one or more of the
following events occurs.

To activate a task: Go to:

On a regular basis page 51
While a point is on scan page 52
When a status point changes state page 53
When a Station function key is pressed page 54
When a Station menu item is selected page 55
When a display button is selected page 56
When a Station prompt is answered page 57
When a display is called up page 58
When a report is requested page 59
When another application requests it page 61

When your task is woken from its TRMO04 call by one of these events you can
usually obtain more information about the event by calling GETREQ. The
parameter block returned from GETREQ can provide event specific information
that can used to determine what action your task should take. Note that if
GETREQ is not called, then the request will not be flushed from the request
queue and no further requests to the task can be made.

The remainder of this section describes how to configure the server to activate
your task for each of these events and also what event specific information you
can obtain from the parameter block.

www.honeywell.com/ps



ACTIVATING A TASK

Activating a task on a regular basis

To get the server to request your task on a regular basis you can make a call to the
application programming library routine TMSTRT while the task is initializing.
This will set up an entry in the server timer table that will cause the server to
activate your task on a regular basis.

To view the current timer table entries:

1 In Station, choose Configure > Application Development > Task Timers to
call up the Task Timers display.

=—— Gystem Configuration Applications
Summary Point Lists System Sinewaves Task Timers Watchdog Timers
B General
E System Hardwrare Timer Currentvalue Reset period Task to Parameters
[ Areas (seconds) (seconds) activate 1 2
Ealarm & Event Management 1 4 o o4 a a a
EOperator Security 2 23 =) 48 1] 1]
EHistory 3 4 5 bed 1 1]
et . P :
3 5 1 1 43 [t} [t}
ETrend & Group Displays
B Acronyms [ 15 [t} B3 g [t}
@ Applications 7 - o o o o
Bapplication Development g - v 0 v v
d) a -1 a a a a
10 -1 a a a a
" -1 [t} o [t} [t}
12 -1 [t} o [t} [t}
13 -1 a o a a
B Server Seripting 14 -1 o o a a
15 -1 a a a a
16 -1 a a a a
17 -1 [t} o [t} [t}
18 -1 [t} o [t} [t}
19 -1 a o a a
20 -1 a o a a |
Timer will be reactivated after the reset period unless the reset period is Tera

To stop the periodic requests

To stop the periodic requests you can use TMSTOP. Note that the TMSTRT
application programming library routine can also be used to activate your task
once-off at some time in the future, rather than periodically.

When activated using this method, your task can call GETREQ to obtain the
following information in the parameter block.

Word Description

1 Set to 0.

2 param] passed to TMSTRT.
3 param?2 passed to TMSTRT.
4-10 Not used.
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Activating a task on while a point is on scan

52

You may want to have an operator control when your task is to be requested on a
regular basis. This can be done by using the PV Algorithm No 16: Cyclic Task

Request.

While a point with this Algorithm is ON SCAN, it will cause the application task
with the specified LRN to be activated on a regular basis. To configure the
Algorithm in Quick Builder, you need to define the following parameters:

Parameter Description

Block No. Algorithm data block number. For details, see the
Configuration Guide.

Task LRN The logical resource number of your task.

Task Request Rate The task request rate in seconds, (must be multiple of

point scan rate).

Word 1(param1)

Must be a non-zero number.

Word 2-10 (param2-10)

Numerical parameters that will be passed to your task.

Notes

* The algorithm block can also be configured from the Cyclic Task Request
Algorithm display. Using the Point Detail display, click the Algorithm number
to display the Algorithm configuration.

» This algorithm must be attached to either a Status or Analog point with no
database or hardware address (that is, Controller number only).

* Time of the last request (in seconds) is stored by the system in ALG(04).

When activated using this method, your task can call GETREQ to obtain the
following information in the parameter block:

Words 1 -10.
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Activating a task on when a status point changes state

You may want to have a task requested based on some change in the field. This
can be done by using the Action Algorithm No 69: Status Change Task Request.

A single request is made to the task with the specified LRN each time the Status

point changes to the nominated state (0-7). Alternatively, a nominated state of -1

will request the task for all state transitions. To configure the Algorithm in Quick
Builder, you need to define the following parameters:

Parameter Description

Block No. Algorithm data block number. For details, see the
Configuration Guide.

Task LRN The logical resource number of your task.

Task Request Rate Nominated state (0-7), or -1 for all state transactions.

Word 1(param1) Must be a non-zero number.

Word 2-10 (param2-10) Numerical parameters that will be passed to your task.

Notes

* The algorithm block can also be configured from the Status Change Task
Request Algorithm display. Using the Point Detail display, click the
Algorithm number to display the Algorithm configuration.

* This algorithm must be attached to a Status point.

+ This algorithm does not queue requests to the task.

When activated using this method, your task can call GETREQ to obtain the
following information in the parameter block:

Words 1-10
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Activating a task on when a Station function key is pressed

The Station function keys can be configured to activate a specific task. The
function keys are configured for each Station. For details, see the Configuration
Guide.
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Activating a task on when a Station menu item is selected

You can configure a menu item to activate your task. For details, see the
Configuration Guide.
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Activating a task on when a display button is selected

If the operator only needs to activate your task when looking at a particular
display, you can place a pushbutton object on that display. The pushbutton object
is configured to activate your task. For details, see the Display Building Guide
(for DSP displays) or the HMIWeb Display Building Guide (for HMIWeb
displays).
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Activating a task on when a Station prompt is answered

A task may often require information from an operator using a particular Station.
You can prompt the operator to type a string in Station’s Command Zone by using

the OPRSTR routine. This routine displays a message prompt in the Message
Zone and returns to the calling function.

When the operator has typed a response and pressed ENTER your task is re-
activated, and you can call GETREQ to obtain the following information in the

parameter block.

Word Description

1 Parameter 1 passed to the OPRSTR routine.
2-10 Not used.
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Activating a task on when a display is called up

You can develop an application task that sits behind a display and performs
additional processing. The display can be configured to activate your task
whenever it is called up, or at regular intervals while it is visible. For details, see
the Display Building Guide (for DSP displays) or the HMIWeb Display Building
Guide (for HMIWeb displays).
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Activating a task on when a report is requested

After a server report has been requested, you may require extra processing of the
report in an application specific way. This is achieved by configuring the report to
request your application task after the report generation is complete.

To configure a report to activate a task:

1 In Station, choose Configure > Reports.

2 Use the scroll bar to find the report you want to change and click the report
name. The report details are displayed.

3 Click the Definition tab on the display. The report definition appears.

—_—— Systern Configuration M8 Report 1 [~]

Definition Content Seripting
E General
B System Hardware —

Report Definition
b Report type Alarm and Event =] (required) Request
BAlarm & Event Management -
E Operator Security Nate: Changing the repart e will clear all getalls of this report
E History Mame unALM
ElReports Title [Test Alarm and Event Report
aE Area | =l

MSchedules Request program LEN [
ETrend & Group Displays Reporting on Request
E ACronyms [E Enahle reporting on reguest
B Applications Destination @ Station Defautt Printer
B Application Development [ | ;|

B Server Scripting

Periodic Reporting
[0 Enable periodic reporting

Destination | =

LI I MM
MNext report 00:00 Previous
Interval | Hone I= |
Cperator I | Ji= | v
Note: If Interval Is set to ‘Wone' then periodic repovting Is disabied Hext

4 In the Request program LRN box, type the logical resource number of your
task.

When activated using the display, your task can call GETREQ to obtain the
following information in the parameter block.

Word Description

1 Station number requesting the report
2 Not used

3 Report number

4-10 Not used

Honeywell 59



5 — CONTROLLING THE EXECUTION OF A SERVER APPLICATION

Attention

The report output file will reside in the report folder of the server and will have the
name RPTrnnn where nnn is the report number.

(<!>>
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Activating a task on from another task

For a complicated application, you may need to implement a solution using more
than one task. To synchronize the execution of each of your tasks, you can request
one task from another.

Use the application programming library routine RQTSKB to request another
task to be activated if it is not already active.

When activated using this method, the receiving task can call GETREQ to obtain
the following information in the parameter block.

Word Description
1-10 Values passed into the requesting tasks call to RQTSKB.
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Testing the status of a task

There are two library routines provided to allow you to wait for or check up on
the status of another task.

In some cases you may want to suspend execution until another task has
performed an operation for you. To do this, call the routine WTTSKB after you
have activated the other task with RQTSKB. WTTSKB will block your task, and
only return when the other task has called its own TRM04.

Rather than suspending your own task, you can check the status of the other task
by calling the routine TSTSKB. This routine will indicate whether the specified
task is active performing some function or dormant in a TRM04 call.
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Monitoring the activity of a task

In some critical applications that you write, it may be desirable to know that the
task written is actually working, and if not, to then take certain actions. Watchdog
timers are provided for this purpose.

Watchdog timers are used to monitor tasks. They operate a countdown timer
which is periodically checked for a zero or negative value. If the timer value is
zero or negative, then the watchdog will trigger a certain predetermined action.
The timer value can be reset at anytime by the task associated with that timer, thus
avoiding the timeout condition.

Watchdog timers are started with a call to the watchdog start routine, WDSTRT,
by the calling task. An action upon failure and a timeout interval (poll interval)
must be specified. The following table describes the actions that can be taken on

failure.

Action on failure setting Description

Alarm Generate an alarm upon failure.

Reboot Restart the server system on failure.

Restart Restart the task on first failure, and reboot the system on
subsequent failures.

The tasks may then reset their watchdog timers by calling the watchdog timer
pulse routine, WDON, which resets the countdown timer to the poll interval
value.

For details on the routines, see WDSTRT and WDON (C and C++).

To check the watchdog timers:

1 In Station, choose Configure > Application Development > Watchdog
Timers to call up the Watchdog Timers display.
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Introduction to databases

66

Databases are basically a store of information to be referenced, altered or deleted
at a later date. Many types of databases exist, but the majority of them can be
classified into three main categories:

* Relational. Relational databases are used heavily in business applications
where the data is represented as various tables, each containing a series of
records and each record containing a set of fields. Due to the nature of the
relational database structures, their strength lies in their ability to support ad
hoc queries and quick searches.

* Object oriented. Object oriented databases are used more in Computer Aided
Design (CAD) applications, where the data relationships are too complex to
map into a table, record and field format. They are usually bound very closely
to an object oriented language and provide better performance than relational
databases.

* Real-time. Real-time databases are used in process control applications where
the performance of the database is paramount. These databases usually consist
of a memory-resident portion to ensure fast operation. The tasks that
references the memory-resident fields can reference them just as if they were
local variables in the program.
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The server database

A knowledge of the server database is essential for programming in the server
environment. Use of the database involves considerations of both performance
and maintenance to ensure minimal impact on other system functions. This
section aims to describe the internal structure of the server database to aid with
this understanding.

The server system makes use of a real-time database to store its data. This data
can be used throughout the whole server system, and by any applications that you
intend to develop. The database provides the primary interface between an
application and the standard server software.

The types of data stored in the server database can be classified as follows:

Type of data Description

Acquired Data Data that has been read from or is related to Controllers.

Process History A historical store of acquired data.

Alarms and Events Details on alarm and event conditions that have
occurred.

System Status Details on the state of communications with remote
devices.

Configuration Data Details on how the server system has been configured to
operate.

User Defined Data Structures to store your own application specific data.
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Physical structure

The term “physical structure” of the server database is referring to the files that
are used by the native operating system to store data. When using the application
programming library routines you will only be referring to the logical structure of
the database, but it is useful to understand how it is physically stored.

The physical structure of the database

The database is made up of a number of files that reside in the data folder. The
data folder is located in <server folders.

To increase performance, some parts of the database are loaded from the hard disk
into the computer’s memory when the system starts. Periodically this memory-
resident data is written back to the hard disk so that it will not be lost if the system
stops.

The database folder contains the following main files.

File Description

data Holds many of the smaller database tables and all of the
memory-resident tables.

history Contains the process history data for each history
interval.

events Holds event data.

crtbkr, crtdfd, crtsha Holds the display definition.

points Contains all the point and parameter details.

The following figure shows how the database is stored.
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Figure 2 Physical database

Physical Database
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Logical structure

When accessing server data, you will typically work with two types of logical
files in the server real-time database:

* Flatlogical files. These are arranged as a set of fixed size flat files, containing
a fixed number of records, with a fixed number of words per record.

* Object-based real-time database files. These are flexible data structures for
which the underlying structure is hidden from the user and can only be
accessed via functions which manipulate the data.
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Flat logical files

To an application, these appear as a set of approximately 400 logical files. Each
logical file stores a set of records of data related to some part of the server system.

An example of a logical file is CRTTBL. This table contains a single record for
each Station on the system. The records of CRTTBL define items like the type of
keyboard connected, the update rate, the current page number and so on.

Figure 3 Logical versus physical structure of database

Logical Database Physical Database
Logical File Logical File Name
1 [Record \
Record 2 DIRTRY_F
Record 400
2
Data\data
(example, C:hs\server\data\data)
> and
other relative files
(for example, history files)
251 UTBLOTF
UTBLO2_F
datalutblxx (or datalutbxxx if value is over 100)
> for example (C:\hs\server\datalutbl01)
400 UTB150_F /

Flat logical file numbers

A unique file number (ranging from 1 to 400) is used to identify each of the flat
logical files. Labels for all the valid file numbers are defined in the include file
files. See the C/C++ Application Template section on how to include this file
into your application.
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Whenever you are reading or writing on a file basis you will need to identify the
flat logical file by providing one of these labels as the file number.

Definition files for flat logical files

The layout of each of the flat logical files is described in a separate definition file
that can be included at the top of your source code. The naming convention for
these definitions files is as follows:

*  GBxxxtb1.h for C/C++ definition files.
Where xxx is part of the flat logical file’s name.

In our example above the definition file for CRTTBL would GBcrttb1.h for C/
C++.

Types of flat logical files

72

There are two common types of record structures for the flat logical files used in
the server database: relative and circular. The structure of the logical file
determines to some extent how you access the data within the file.

Relative files

Relative files are used where data needs to be stored in a structured way, with
each record representing a single, one off entity. An example of a relative file is
the CRTTBL where each record represents a single Station. The majority of flat
logical files in the server are relative files.

Access to a relative file is achieved using specific functions like GETVAL or
using a generic read and write function of DATAIO. If you use DATAIO you will
need to provide a record number which is relative to the beginning of the logical
file. The record number acts like an index to identify the data—that is, to access
data regarding the third Station you would access record three of the logical file
CRTTBL.
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Figure 4 Relative file structure

Record 1

Record 2

Record 3 ——» read record 3

Record n

Circular files

Circular files are used where data needs to be recorded on a regular basis, but
there is a limit on the amount of disk space that is to be used. When the circular
file is full, and a new record is written to it, the oldest record will be removed. An
example of a circular file is a HISTORY file where each record represents a set of
point parameter values at a given time.

Access to a circular file is achieved using specific functions like GETHST or
using the generic dequeue, queue, read oldest, read newest, or write newest
functions of DATAIO.
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Figure 5 Circular file structure

74 www.honeywell.com/ps



THE SERVER DATABASE

Object-based real-time database files

In addition to the logical files, some data is stored in object-based real-time
database files. This data is accessed by various API calls, and the structure of the
data is hidden from the user.

An example of such a file is the points database file, whose manipulation
functions (or methods) are described in “Accessing acquired data” on page 77.
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Ensuring database consistency

76

The logical files in the server database are shared by all the tasks and users of the
system. This data sharing capability can cause problems if data is not sufficiently
protected.

For example, consider the situation where two tasks are simultaneously accessing
the same record in a logical file. They both read the record into a buffer in
memory and proceed to modify its contents. The first task completes its
modification and writes the buffer back to the record in the logical file. A moment
later the second task does the same, but it will overwrite the changes made by the
first task.

There are two ways to overcome this problem. The first method is to design your
tasks so that only one task is responsible for changing the record contents. This
task (hsc_lock_record) knows that it is the only one changing the record, so it
can go ahead and read and write to its hearts content.

The second method is to use file locking. Before performing a read, modify, write
sequence your task can call hsc_lock_file to request permission to change the file.
If another task has the file already locked you will be denied access. If the file is

not locked, it will be locked on your behalf and you will be able to read, modify

and write the record. After you are complete you should call hsc_unlock _file to

allow other tasks to access the file.

Object-based real-time database files do not require such locking. Instead the
methods of the file will ensure database consistency.

In most cases you will not need to lock and unlock files or records in your
application as the server will perform the necessary locking on your behalf. The
exception to this rule is when you are using user tables (see “Accessing user-
defined data” on page 89) with more than one task reading and writing to their
records. In this case you will need to use the file locking functions of hsc_lock_
file or hsc_lock_record.
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Accessing acquired data

The data acquired from controllers is stored in an object-based real-time database
file, and is accessible to all processes via API calls. The structure of this file is
hidden from the API user by the calls used to manipulate it.
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Identifying a point

Before you can access the data from a particular point you need to determine its
internal point number. This internal point number is used by several of the
application programming library routines to quickly identify the point.

An application will normally determine the internal point number of several
points during initialization. To do this the application passes the Point Name in
ASCII to the library routine hsc_point_number. If the point exists in the
database, this function will return its corresponding internal point number.
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Identifying a parameter

A point comprises many individual point parameters, for example, SP, OP, PV
and so on. When you want to refer to one of these parameters in your application
you need to use hsc_param_number to resolve the parameter name to its
appropriate number. This routine accepts an ASCII string for the parameter name
and the point number and if the parameter exists for this point then its
corresponding number will be returned. Parameter numbers may vary from point
to point (even within the same point type), so parameter names need to be
resolved to parameter numbers on a point by point basis.
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Accessing parameter values

80

To read the current value of a list of parameters, use the hsc_param_values
function, which accepts a list of point and parameter numbers and returns their
current value(s).

To write to the value of a particular point’s parameter you can call hsc_param_
value_put, passing it the internal point number, the point’s parameter number
and the new value. If the parameter has a destination address the Controller will
be controlled to the new value. If you do not want such control to be performed
use the related write function hsc_param_value_save, which performs an
identical function but without the control to the parameters destination address.

If the current value for the point is a bad value, then an error code will be
returned, and the parameter value you receive will be the last good value for that
point’s parameter.
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Using point lists

If your application needs to simultaneously read from/write to several point
parameters, you can create a point list which defines the relevant point
parameters. (You configure the point list in Station.)

After you have created the point list, your application can use the library routine
GETLST to read the set of point parameters, and GIVLST to write the set of point
parameters.

For details on the routines, see GETLST and GIVLST (C and C++).

To create a point list:

1 Choose Configure > Application Development > Application Point Lists
to call up the Point Lists display.

2 Use the scrollbar to show the point list you want to change.

3 Click the list you want to configure to call up the Application Point List
display.

Figure 6 System configuration—Application Point display

*==— System Configuration Application Point List 1 o=
B General Application Paoint List Description
E:‘:::Zm ey Paint ID Point Description Parameter History Offset
B e R et 1 [oTCOMPTLYVL ]G4S COMP 1 LEVEL | —— o [
@ Operator Security 2 [01COMP2LYL =] s COMP 2 LEVEL | —— [
e History 3 [OTCOMPIPRES ] GAS COMP 1 PRESS PV I | 0
EIReports 4 [DTCOMPZPRES =] ©Bas COMP 2 PRESS Py = | 0
BSchedules 5 [ I | ]
B Trend & Group Displays 3 ] | | 0
7 =] =1 | ]
& = = | 0
a = = o[
10 = I | 0
1 ) = 0
12 | I 0
13 =] | — ] [
14 = =] | ]
15 = I | 0
15 = = | 0
17 =] =l 0
18 = =1 [ ]
18 = =1 | ]
20 = =1 | ]

4 For each point parameter you want to control, type the point ID and parameter.

5 If the point parameter is a history parameter you can also define the history
offset.
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Controlling when data is acquired and processed for standard points

82

This section only applies to analog, status and accumulator points

Rather than having data acquired on a periodic basis, you can configure specific

points to have the data acquired at the control of an application. This is typically
done if the acquired data is only used by the application, or if the data is critical in
a calculation and it must be the current field value.

If the acquired data need only be used by the application, you can configure the
point so that it does not have a PV PERIOD entry. This will mean that no periodic
scanning of the value is performed.

There are several library routines that can be used to control when data is
acquired and processed from status, analog, and accumulator points:

Routine Description

SPSW Scan Point Special and Wait for Completion
SPVW Scan Point Value and Wait for Completion
SPS Scan Point Special

SPV Scan Point Value

PPSW Process Point Special and Wait for Completion
PPVW Process Point Value and Wait for Completion
PPS Process Point Special

PPV Process Point Value

The routine SPSW will demand a point parameter to be scanned from the field. If
the value scanned has changed then the point parameter will be processed (that is,
checked for alarm conditions, execute algorithms where necessary, and so on),
store the value in the point record, and then return.

The routine SPVW is used when there is no source address for the point
parameter. This allows you to point process a calculated value from your
application just as if it were scanned from the field, that is, store the value in the
PV, and process algorithms, alarms etc.

The routines SPS and SPV are exactly the same as SPSW and SPVW respectively
but they return immediately and do not wait for the processing to complete. These
are typically used to improve performance if you have several point parameters
on the same Controller to demand scan. Call SPS to quickly queue all the point
parameters except the last one. Then call SPSW to queue the last point parameter
and wait for all to be processed.
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The routines PPSW, PPVW, PPS and PPV are again very similar to the previous
routines mentioned except that they will always force the processing of the point
parameter even if it has not changed. For performance reasons, we do not
recommend you to use these routines unless absolutely necessary.

The routine SPV may also effect the performance of the server adversely if used
heavily. If you need to perform a lot of point processing of application values you
may consider using the user scan task instead.
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Accessing process history

The server can be configured to keep a historical record of acquired data. This
historical data can be shown in Station using the standard trend displays or
custom charts.

There are three categories of historical data that can be retained.

+ Standard history allows the recording of a snapshot value every minute, and
calculated averages at six minute, one hour, eight hour, twenty four hour
intervals.

* Fast history allows the recording of a snapshot value at regular intervals
(configurable between 1 and 30 seconds).

» Extended history allows the recording of snapshot values at one hour, eight
hour and twenty four hour intervals.

Note that these intervals can be changed using the sysbld utility. For details, see
the Configuration Guide.

Accessing blocks of history

An application can also access the historical data stored in the server database
using the library routine GETHSTPAR. This routine allows you to retrieve a
block of historical values for certain point parameters.

When referencing what history to retrieve you may specify it by either a date and
time or by an offset of sample periods from the current time.
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Accessing other data

((!))

All other data in the server database (configuration, status, alarm and event data)
can be accessed in a more generic fashion.

Attention

Accessing other data in this way requires knowledge of the internal structures used by the

server. Although these are described in the definition files, Honeywell does not guarantee
that these formats will not change from release to release of the server.
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Accessing logical files
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The library routine DATAIO is a generic means of reading and writing to any of
the 400 or so logical files in the server database. It allows you to read or write
records (in blocks or one at a time) to or from an integer*2 buffer.

After the record is in the integer*2 buffer you need to refer to the relevant
definition file on the layout of the record. Based on the definition file you can
access the individual fields as follows:

16 bit integer data can simply be assigned to other variables.

32 bit integer data can be equivalenced or accessed via the macros 1dint4 ()
and stint4() in C/C++.

floating point data can be equivalenced or accessed via the macros 1dreal ()
and streal() in C/C++.

double precision floating point data can be equivalenced or accessed via the
macros 1ddb1() and stdb1() in C/C++.

strings can be retrieved from the buffer using INTCHR.
strings can be stored into the buffer using CHRINT.
strings can be converted to upper case before storing using UPPER.

dates stored in Julian days can be converted to day, month and year using
GREGOR and back again using JULIAN.
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Accessing memory-resident files

When the logical file is memory-resident you can reference the records by way of
global variables rather than using DATAIO. These global variables are located in
shared memory, and are common to all tasks.

& Caution

Accessing other data using shared memory not only requires knowledge of the internal
structures but also requires care. It is very easy to accidentally alter database values just
by setting these global variables.

Values are read from the memory-resident file simply by assigning the global
variable to another variable. Values are written to the memory-resident file simply
by setting the value of the global variable. The set value will be written back to
disk automatically when the server performs its next checkpoint if the value is
stored in a checkpointed file.

In C the variables for the memory-resident files are defined in separate include
files called GBxxxtb1.h, where xxx is the name of the logical file. The global
variables are arrays of structures (one structure per record) that have a name of
GBxxxt1b[]. For example:

#include “src\GBtrbtb1.h”
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DIRTRY (The first logical file in the server database)

88

The first logical file in the server database is a memory-resident file called
DIRTRY. It contains one record for every logical file in the server database.
Record 1 represents logical file 1, record 2 represents file 2 and so on right up to
the last record.

Each of these records defines the attributes of the corresponding logical file. This
includes the type of logical file, whether the file is memory-resident, the
maximum number of records the file can contain, the number of active records,
the record size in words and other data used internally by the server.

For example, if you wanted to determine the number of Stations that have been
implemented in your system.

In C/C++ we would reference the global variable GBdirtry[n-1].actvrc. The
field actvrc contains the number of active records, and the value n represents the
nth record of DIRTRY. In this case, n is CRTTBL_F since we are concerned with
the number of Stations defined in the CRTTBL.

crtmax = GBdirtry[CRTTBL_F - 1].actvrc;
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Accessing user-defined data

The server system provides the application developer with 150 database files for
application-specific storage. These files are called user tables (or user files), and
are referred to as user tables 1 through to 150, occupying file numbers 251 to 400
respectively.

In order to use these tables with applications, you must first configure the table(s)
to be used. This involves specifying the type of table, the number of records in the
table, and the size of each record.

The type of table may be either relative (direct) or circular. Direct or relative
tables are linear in structure, and may be indexed via a record number. Circular
files are, as the name implies, circular in nature, giving you the ability to
continually write to a table by incrementing the index, with the actual index
simply looping back to the beginning of the table when the record pointer exceeds
the maximum number of records in the table.

The server has the first three user tables (tables 1-3, database file numbers 251-
253) preconfigured to certain values, the values being:

Table Number File Type Number of Records Record Size (words)
1 DIRECT 20 128
2 DIRECT 20 128

DIRECT 20 128

If you want to configure or modify any of the 150 user tables, you can use the
user table builder utility, utbbld.
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Displaying and modifying user table data

Experion gives the you the ability to view and modify data within database files
using custom displays. Thus if an application uses a user table, you can also
create a display to view and/or modify this data.

For details about creating displays, see the Display Building Guide (for DSP
displays) and the HMIWeb Display Building Guide (for HMIWeb Displays).
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Setting up user tables using the UTBBLD utility

The utbbld command-line utility can be used to:

View the existing table configurations
Configure new user tables
Modify existing user table configurations

Delete existing user tables

For usage notes, see “UTBBLD usage notes” on page 96.

UTBBLD example

This example shows a session that uses utbbld to carry out its full range of
actions, namely:

Display the existing user table configurations
Modify the configuration of user table 42

Add user table 21, with the configuration: CIRCULAR file type, 64 records, 18
words per record

Delete user table 4

Display the new user table configurations

The session which carried out these actions is as follows:

utbbld
System status is OFF-LINE
USER TABLE BUILDER

Main Menu.

1. pisplay current user table configuration

2. Modify existing user tables

3. Add user tables

4. Delete user tables

c. Commit changes

g. Quit

Please choose one of the above (default is q):

1
System User Table Configuration

User Table File File Type Number of words per
Number Number Records Record

1 251 DIRECT 20 128

2 252 DIRECT 20 128

3 253 DIRECT 20 128

4 254 DIRECT 20 12

42 292 CIRCULAR 10 1

Total configured tables = 5. Number of free tables = 145
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Hit ENTER to continue:

USER TABLE BUILDER

Main Menu.

1. Display current user table configuration
Modify existing user tables

Add user tables

Delete user tables

Quit

o b~ whN

Please choose one of the above (default 1is q):
2

Modify One or More User Tables.
The following tables are configured:
1 2 3 4 42

Please enter the user table number you wish to modify, or q to
return to the main menu (default is q):

42

File number selected is 292

The configuration for this user table is:
File type is CIRCULAR

There are 10 records,

And the record size is 1 words.

Do you want the file to be circular?

Please type (y)es, (n)o or ENTER (default is N0O)? (Y/N) NO
Direct (relative) File Type

Record Size Is 1 words
Enter required record size
( 1 to 32767 are allowed, or <return> to leave unchanged)
42 entered.
There are 10 records
Enter required number of records
(1 to 32767 are allowed, or <return> to leave unchanged)
42 entered.

The configuration for this user table is:
File type is RELATIVE (DIRECT)

There are 42 records,

And the record size is 42 words.

Are these values 0OK?

Please type (y)es, (n)o or ENTER (default is YES)
y
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Do you wish to view/modify another table?
Please type (y)es, (n)o or ENTER (default is NO)
no

USER TABLE BUILDER

Main Menu.

. Display current user table configuration
Modify existing user tables

Add user tables

Delete user tables

Quit

lease choose one of the above (default is q):

W UTvTaoO P~ wWNPRE

Add a New User Table

You may choose the user table number to add, or
let the system choose the next available user
number for you.

1. choose the user table number to add

2. Let system choose the new number

g. Return to the main menu

Please choose one of the above (default is q):
1

Currently configured tables are:
1 2 3 4 42

There are 145 free tables remaining, please
choose a free user table number (between 1 and 150).

Enter required table number
( 0 to 150 are allowed, or <return> to leave unchanged)
21 entered.
(This is file number 271).

Do you want the file to be circular?

Please type (y)es, (n)o or ENTER (default is NO)? (Y/N)
YES

Circular File Type

Record Size Is 1 words
Enter required record size

( 1 to 32767 are allowed, or <return> to leave unchanged) 18
entered.

There are 1 records
Enter required number of records

( 1 to 32767 are allowed, or <return> to leave unchanged) 64
entered.
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The configuration for this user table is:
File type is CIRCULAR

There are 64 records,

And the record size is 18 words.

Is this information OK?
Please type (y)es, (n)o or ENTER (default is YES) (Y/N)
YES

would you 1like to add more user tables?
Please type (y)es, (n)o or ENTER (default is NO) (Y/N)
NO

USER TABLE BUILDER

Main Menu.

Display current user table configuration
Modify existing user tables

Add user tables

Delete user tables

Commit changes

Quit

o N M WN R

Please choose one of the above (default 1is q):
4

Delete One or More User Tables.
The following user tables are configured:
1 2 3 4 21 42
Please enter the user table number you wish to
delete, or q to return to the main menu (default 1is q):
4

File number selected is 254

Do you wish to delete this table?

Please type (y)es, (n)o or ENTER (default is no) (Y/N)
YES

WARNING : this will remove all information in this table.

Do you still wish to delete this table ((y)es/(n)o[default])?
(Y/N)

YES

Table has been deleted.

The following user tables are configured:
1 2 3 21 42

Please enter the user table number you wish to
delete, or q to return to the main menu (default 1is q):

q
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USER TABLE BUILDER

Main Menu.

Display current user table configuration
Modify existing user tables

Add user tables

Delete user tables

Commit changes

Quit

o0 N b WN R

Please choose one of the above (default is q):
1

System User Table Configuration

User File File Type Number of words per
Table Number Record Record
Number 3

1 251 DIRECT 20 128

2 252 DIRECT 20 128

3 253 DIRECT 20 128

21 271 CIRCULAR 64 18

42 292 DIRECT 42 42

Total configured tables = 5. Number of free tables = 145.
Hit ENTER to continue:

USER TABLE BUILDER

Main Menu.

1. Display current user table configuration
2. Modify existing user tables

3. Add user tables

4. Delete user tables

g. Quit

Please choose one of the above (default is q):
C

Updating the modified user tables.......

USER TABLE BUILDER

Main Menu.

1. Display current user table configuration

2. Modify existing user tables

3. Add user tables

4. Delete user tables

g. Quit

Please choose one of the above (default is q):
q
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UTBBLD usage notes

Running UTBBLD with the server running/stopped

It is recommended that any changes to user tables using the utbbld command be
made with the server system stopped. However, the server database service
should be left running as utbbld requires access to the server database. Making
changes to user tables with the server running is not recommended, as doing so
can affect applications that are currently accessing the user tables.

Viewing user table configuration

(<!>>

If you only use utbbld for viewing the current configuration, then utbbld can be
safely executed while the server is running.

To use utbbld without stopping the server, use the -force option:
utbbld -force

Attention

This option is not recommended because it may disrupt applications that are running, and
changes may not be able to be made to files that are in use.

Preservation of existing files

utbbld attempts to preserve data in existing user tables. However, any changes to
the number of records or the size of the records in the user table might cause loss
of data. The user table could become smaller if either the number of records is
reduced, or, the number of words per record is reduced.

Running UTBBLD in a redundant server system

96

When you make changes to user tables using the utbbld command on the primary
server, synchronization with the backup server is lost. You need to manually
synchronize the servers so that the changes are replicated to the backup server.

After you have synchronized the servers, it is good practice to ensure the user
table changes have been correctly replicated to the backup server.
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Using the database scanning software

The database scanning software, DBSCN, enables Experion to utilize user table
addresses as point source and destination addresses.

In most cases, where a point is required to access the server database, a “database
point” can be built to accomplish this. These database points are best suited to
accessing small amounts of data which may be dispersed throughout the server
database.

Occasionally, applications require a substantial amount of point data to be derived
from the server database. This data would normally reside in user tables. As
scanning data using standard database points can result in significant system
loading, it should be avoided. Instead, DBSCN should be used to provide a more
efficient method of scanning point data from the server database.
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Working from a Station

The application interface library provides routines that, when working from a
Station, enable you to perform the following tasks:

* Generate alarms

* Display messages

* Print files

* Control custom built X-Y charts
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Running a task from a Station

100

You run a task from a Station by:

Pressing a function key
Selecting a menu item
Clicking a button on a display
Answering a prompt

Calling up a display

Each of these methods of task activation, and the parameters passed in the
parameter block, are described in the section “Activating a task” on page 50.
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ROUTINE FOR GENERATING AN ALARM

Routine for generating an alarm

When a task determines some critical condition has occurred, to alert all the
operators at each Station you can generate an application alarm or event using the
routine hsc_notif send.

Alarms usually indicate that an abnormal condition has occurred and that some
action should be taken by the operator. Alarms can be given one of three
priorities; low, high, or urgent. Depending on other alarms in the system and how
the alarm is configured, the alarm can appear in the Alarm Zone on each Station
and cause the audible annunciator to sound. The alarm can also be printed to an
alarm/event printer. All alarms are recorded in the event file.

Events usually indicate that some condition has occurred that needs to be logged
or recorded. They are not added to the alarm list but are printed to the alarm
printer if it has been configured.

Honeywell 101



7 — WORKING FROM A STATION

Routine for using the Station Message and Command
Zones

You can use the OPRSTR library routine to display less-important messages on a
particular Station’s Message Zone.

This routine enables your task to display the following types of messages:

* Information messages that remain in the Message Zone until another
message appears.

« Indicator messages that are automatically cleared after a certain period of
time.

* Prompt messages that ask the operator to type some information in the
Command Zone. When the operator types a response in the Command Zone
and presses ENTER, Station activates the task enabling you to retrieve the
operator’s response by calling OPRSTR in C/C++.
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ROUTINE FOR PRINTING TO A STATION PRINTER

Routine for printing to a Station printer

An application can generate information associated with a particular Station that
you want to print to a printer. For this to happen, you need to write the
information to an operating system file and use the library routine PRSEND.

PRSEND enables you to queue the operating system file to print on the Demand
Report printer associated with the Station. It also enables you to queue the
operating system file to print on a specific printer as well.
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Developing user scan tasks

To introduce unsupported controller-like devices into your system, you can either
create an OPC server for your device, or you can use the User Scan Task option to
write an application which provides an interface between the device and
Experion.

The recommended way is to create an OPC server. This method eliminates the
requirement of writing a custom interface by defining a common, high
performance interface that permits this work to be done once, and then reused.

You will find the OPC specification on the Internet at: http://

www . opcfoundation.org. The OPC Specification is a non-proprietary technical
specification that defines a set of standard interfaces based upon Microsoft’s
OLE/COM technology. The application of the OPC standard interface makes
possible interoperability between automation/control applications, field systems/
devices and business/office applications.

However, should you choose to use the User Scan Task to write an interface
application, you will find this option described below.

The link between the server and the User Scan Task is the Experion database user
tables. The server provides database scanning software (DBSCN) to scan data
from the user tables into server points. The User Scan Task reads data from the
remote device and writes it into the user tables. Experion can also send controls to
the remote device by way of the User Scan Task.

Honeywell 105



8 — DEVELOPING USER SCAN TASKS

Figure 7 User scan task

Controller

User Tables

The option works by using channels defined as “User Scan Task” type channels.
These channels operate in exactly the same manner as a conventional channel.
They interact, however, with “User Scan Task” controllers rather than physical
controllers.

Point parameters are sourced from these database controllers by specifying the
word address within the specific record.

For details about defining a user scan task controller, and its associated channel
and points, see Quick Builder’s help.
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DESIGNING THE DATABASE FOR EFFICIENT SCANNING

Designing the database for efficient scanning

In order to achieve maximum efficiency when using DBSCN to scan the
database, the greatest number of point source addresses should be scanned using
the fewest scan packets.

When considering the physical layout of data within a user scan task controller,
the following points should be noted:

* Addresses which are scanned at the same rate should be grouped together so
that they fall into the same scan packet where possible. The scan processor
automatically processes the controller from lowest to highest address and
starts a new scan packet each time a scan rate change is detected.

e The number of scan rates in use should be minimized. If only a few points are
built for a given scan rate, it may be more efficient to scan them at the next
fastest scan rate of many points that are already built on that scan rate.
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Example user scan task

108

This section includes an example of how to use a User Scan Task.

The example alters the first four values of user table #1 (file number UTBLO1_F)
every 10 seconds. It employs many important routines from the application
library described in this manual, including DATAIO, GBLOAD, TRMO04 and
TRMTSK.

The example also demonstrates the use of two important routines, GDBCNT and
STCUPD. GDBCNT is used to fetch and decode point control requests from the
Station, while STCUPD is used to manipulate the sample time counter used to
monitor tasks. For a further description of these routines, see “Application
Library for C and C++” on page 127.

Note that the program does not actually communicate with a real physical device.
This would be accomplished using standard techniques for accessing the device
to be used in the section of the program which is labelled “(read data from some
device or file)”.

The example provides a C/C++ version of the user-written scan task. It also
provides the point and hardware definition files used in conjunction with the
program in order to define the database channels, and so on. The example can be
found in the folder: <server folder>\user\examples\src.

You may want to create a custom display that shows the contents of the first four
locations of user table 1 so that table updates can be viewed as they occur. For
details, see the Display Building Guide (for DSP displays) and the HMIWeb
Display Building Guide (for HMIWeb displays).
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EXAMPLE USER SCAN TASK

CI/C++ version

The C version of the example User Scan Task is included here. For more
information regarding any of the functions called in this program, see
“Application Library for C and C++” on page 127.

Fededededehdefededefededehdefdedehdefhdefddehdefddehdedhdefddedededddefddeddend

COPYRIGHT © 1996-1999 HONEYWELL PACIFIC
**/

/
#incTlude <errno.h>
#include "src/defs.h"
#include "src/environ.h"
#include "src/mM4_err.h"
#include "src/dataio.h"
#include "files"
#include "src/trbtbl_def"
#define FILE UTBLO3_F /* user file number */
#define RECORD 1 /* user record number */
#define RTU 1 /* user controller number */
#ifndef Tint
static char *ident="@(#)c_dbuser.c,v 720.3";
#endif
static char *progname="c_dbuser.c,v";
/*
BEGIN_DOC

SUMMARY :
Example user scan task

*/

main

{

/*
DESCRIPTION:

Add DBUSER as application via application display.
Give it a user 1rn and a user file number.
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DBUSER acquires data and stores the data in a user file.
DBUSER accepts control requests to write data.

DBUSER updates controller's Sample Time Counter (watchdog) to
keep

controller "healthy'.

RETURN VALUES:
FUNCTIONS CALLED:
RELATED FUNCTIONS:
DIAGNOSTICS:
EXAMPLES:

END_DOC
*/

#define BUFSz 10000
int2 buffer[BUFSz]; /* file buffer */

struct prm prmblk; /* task parameter block */
int2 cntfil; /* control file number */
int2 cntrec; /* control record number */
int2 cntwrd; /* control word number */
int2 cntbit; /* control bit number */
int2 cntwid; /* control data width */
double cntval; /* control value */
int tsklrn; /* task's 1rn */
int recnum; /* dataio record number */
/:':
* Attach global common
*/

if (c_gbload() == -1)

{

c_logmsg(progname, 214" ,"DBUSER: common load error
%x" ,errno);

return (errno);
}

Find task's 1rn

tsklrn = c_getlrn(Q);
if (tsklrn !'= -1)
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{

= -1)
{
if (errno != M4_QEMPTY)
{
c_logmsg(progname, 236", "DBUSER: gdbcnt() error
%x" ,errno) ;
b
if (c_getreq((int2 *)&prmb1k)==0)
{
switch (prmblk.paraml)
{
case 1
[F mmmmm e service periodic requests-----------
_________ /
/:‘: :':/
/* perform data gathering */
/7‘: 3':/
/* (read data from some device or file) */
/:‘: :':/
/* Lock user file */
/7‘: 3':/
/* if (hsc_lock_file(file,10000) == -1)
c_logmsg(progname, 252" ,"DBUSER: file %d lock
error %x",errno);
else
{...}
:':/
/:‘:
* Read user file
*/

c_tmstrt_cycle ( 10, 1, 0 ); /* every 10 seconds */

EXAMPLE USER SCAN TASK

Start a timer

Get task request

while (TRUE)

if (c_gdbcnt(&cntfil,&cntrec,&cntwrd,&cntbit,
&cntwid,&cntval)

rechum = RECORD;

if (c_dataio_read_newest(FILE,&recnum,
LOC_MEMORY, buffer,BUFSz)==-1)

{
c_logmsg(progname,'262","DBUSER: file %d
record %d read error %x",

FILE,recnum,errno);
}

else/* dataio succeeded */
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{
/7’:
* Update data in user file
* [The following is to provide live data to dbscan
for testing]
* [increment and decrement some values]
:':/
buffer[0] += 10;
buffer[1] -= 10;
buffer[2] += 10;
if (buffer[2]>10000) buffer[2]
-= 10000;
buffer[3] -= 10;
if (buffer[3]< 0) buffer[3] +=
10000;
/:“:
* write user file
7':/
if (c_dataio_write(FILE,recnum,
LOC_MEMORY , buffer,BUFSZ)==-
D
c_Tlogmsg(progname, "283",
"DBUSER:

file %d record %d
write error

%",
FILE,recnum,
errno) ;
else
/:“:
* Update sample time counter if all is OK
7':/
if (c_stcupd (RTU,65) == -
1) /* must
be >60 */
c_Tlogmsg(progname, 290", "DBUSER: stcupd error %x",errno);
} /* if dataio succeeded */
/:':
* Unlock user file
*/
(hsc_unTlock_file (file)(tsklrn,
FILE);
[F mmmmm e end periodic requests------------—-—---
_______ :‘c/
break;
default:
c_logmsg(progname, "301", "DBUSER:
unknown

function %d",prmblk.paraml);
} /* end switch */
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EXAMPLE USER SCAN TASK

} /* end if getreq succeeded */
else if(errno != M4_EOF_ERR)
{
/* getreq failed, and it's not simply because
there is nothing to do */
c_Togmsg(progname, 308", "DBUSER: GETREQ
error
0x%x" ,errno) ;
c_trm04(0);
}
else
{
c_trm04(0); /* no work to do */
3
}
else /* GDBCNT succeeded */
/¥ e service control requests -------------
______________ */
{

c_logmsg(progname,'319","DBUSER: has control
request for

%d %d %d %d %d %f",
cntfil,cntrec,cntwrd,cntbit,cntwid,cntval);

/*

* Interpret what file/record/word/bit/width
means

* perform required action

*/

}
} /* end while */
/* This point is never reached */

}
else /* tsklrn == -1 */
{
c_logmsg(progname,"","start c_dbuser as a task. Use \
"ct\" and supply a user 1rn");
} /* if tsklrn == -1 */
return (0);
}
/

R R o R Rk

COPYRIGHT © 1996-1999 HONEYWELL PACIFIC
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ADDTSK

116

Add application task.

Synopsis
addtsk name Trn [priority]

Part Description
Irn The LRN you have chose for the task, see “Selecting an
LRN for a task” on page 46.
priority The priority of task execution (use 0 as a default).
name The executable file name of your task.
Description

This utility loads the executable program identified by name and prepares it for
execution. Once loaded the executable becomes a task with the given LRN and
priority ready to be activated.

This utility only works with application LRNs, preventing you from accidentally
overwriting a server system task. Use CT if you need to use a reserved LRN for
your task.

Example
addtsk usrapp 111 0
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CT

CT

Create task.

Synopsis
ct 7rn priority -efn name
Part Description
Irn The LRN you have chose for the task, see “Selecting an
LRN for a task” on page 46.

priority The priority of task execution (use 0 as a default).

name The executable file name of your task.

Description

This utility loads the executable program identified by name and prepares it for
execution. Once loaded the executable becomes a task with the given Irn and
priority ready to be activated.

Only use this utility if you have run out of application LRNs and you need to use
areserved LRN for your task. It is preferable to use the ADDTSK utility because
it will check that you are not overwriting server system tasks.

Example
ct 111 0 -efn usrapp
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DBG

Configure Experion so that the next task started from the command line or Visual
Studio that calls ghload() will automatically be assigned the specified LRN.

Synopsis
dbg 7rn
Part Description
Trn The LRN you have chosen for the task, see “Selecting an
LRN for a task” on page 46.
Description

This utility sets up Experion so that the next manually started task will run with a
specified LRN. This is useful for debugging purposes, as it allows a task to be run
from within Visual Studio.

Example
dbg 111
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DT

DT

Delete task.
Synopsis
dt 7rn
Part Description
Irn The LRN you have chose for the task, see “Selecting an
LRN for a task” on page 46.
Description

This utility marks the specified task for deletion. When the task next calls either
TRMO04 or TRMTSK, the task will be deleted.

Only use this utility if you have run out of application LRNs and you needed to
use a reserved LRN for your task. It is preferable to use the remtsk utility because
it will check that you are not removing server system tasks.

Example
dt 111
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ETR

120

Enter task request

Synopsis
etr 7rn [-wait] [-arg argI]
Part Description
Irn The LRN you have chose for the task, see “Selecting an
LRN for a task” on page 46.
-wait Wait for the task to become dormant
-arg argl Additional argument passed to the task via rqstsk
Note: The task is requested via rqstsk—the additional
argument can only be an int2.
Description

This utility requests the specified task to be activated.

Example
etr 111 -arg 5
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FILDMP

FILDMP

Dump/restore the contents of a logical file.

Synopsis
fildmp

Description

This interactive utility is used to dump, restore or compare the contents of server
logical files with standard text files.

When dumping the contents of a logical file to an ASCII operating system file
you will need to provide the operating system file name to dump to, the server file
number, the range of records to dump, and the data format to dump. Note that the
logical file can be dumped to the screen by not specifying an operating system
file.

The data format to dump defines how the logical file data will be written to the
ASCII operating system file. You can specify INT for integer data, HEX for
hexadecimal data, ASC for ASCII data, and FP for floating point data.

When restoring from an operating system file you will only need to provide the
operating system file name. The utility will overwrite the current contents of the
logical file with what is defined in the operating system file.

Example

System status is OFF-LINE
Reading from disc. writing to memory,disc,link.

Enter FUNCTION: 1-dump, 2-restore, 3-compare

1

Enter DEVICE/FILE name

sample.dmp

Enter FILE number

251

Enter START,END record number

1,2

Enter FORMAT: “INT”,“HEX”,“ASC”,“FP”
HEX

File 251 record 1 dumped

File 251 record 2 dumped

Enter FILE number

Enter FUNCTION: 1-dump, 2-restore, 3-compare
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FILEIO

Modify contents of a logical file.

Synopsis
fileio

Description

This interactive utility is used to modify the contents of individual fields in a
logical file.

You will need to provide the file number, whether to modify memory/disk/both,
the record number and the word number of the field to modify and the new value.

Example
Database contains 400 files
File number (=0 to exit) ? 251
Use memory image [YES|NO|BOTH(default)] ?
File 1 contains 400 records of size 16 words
Record number (=0 to back up) ? 1
word offset (=0 to back up) ? 1
Mode =0 to back up
=1 for INTEGER (int2)

=2 for HEX (int2)
=3 for ASCII
=4 for F.P. (real)

=5 for SET bit

=6 for CLR bit

=7 for LONG INTEGER (int4)

=8 for LONG F.P. (dble) ? 1
INTEGER VALUE = -32768 NEW VALUE = 100
Save value [YES|NO(default)] ? YES
word offset (=0 to back up) ?
Record number (=0 to back up) ?
File number (=0 to exit) ?
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REMTSK

REMTSK

Remove application task.

Synopsis
remtsk 7rn
Part Description
Irn The LRN you have chose for the task, see “Selecting an
LRN for a task” on page 46.
Description

This utility marks the specified task for deletion. When the task next calls either
TRMO04 or TRMTSK, the task will be deleted.

This utility only works with application LRNs, preventing you from accidentally
removing a server system task. Use DT if you need to use a reserved LRN for

your task.

Example
remtsk 111
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TAGLOG

List point information

Synopsis
taglog

Description

This utility lists information associated with the specified points in the server
database. This utility is useful to find out if a point exists and to determine its
internal point number.

Example
An example of output from the utility:
Point IPCSTAl Type O Number 1 STALOG PERFORM
TEST 1

DAT file C800 0000 0000 0000 OOFO 0000

EXT file 0000 0000 0000

CNT file 0000 0000 0005 0030 0000 FFOO FFFF 0000 FFOO FFFF

FFOO FFFF 0000 FFOO FFFF FFOO FFFF FF10 0000

DES file 4950 4353 5441 3120 2020 2020 2020 2020 5354 414cC
IPCSTAl STAL

4F47 2050 4552 464F 524D 2054 4553 5420 3120 2020 oOG
PERFORM TEST 1

2020 2020 2020 0000 0000 0000 0018 3000 0000 0000

0000 0000 0000 0000 0000 0000 0000 0000 0000 0000

0000 0000 0000 0000 0000 0000 0000 0000 0000 0000

0000 0000 0000 0000 0000 0000
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USRLRN

USRLRN

Lists LRNs. For details about this utility, see the Configuration Guide.

Honeywell 125



9 — DEVELOPMENT UTILITIES

126 www.honeywell.com/ps



Application Library for C and

C++

The C/C++ application library contains the following functions:

ALMMSG
AssignLrn
BADPAR
CHRINT
CTOFSTR
DATAIO
DeassignLm
DELTSK
DbletoPV
dsply Im
EX
FTOCSTR
GBLOAD
GDBCNT
GETAPP
GetGDAERRcode
GETHSTPAR
GETLRN
GETLST
GETPRM
GETREQ
GIVLST

hsc_asset get ancestors
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hsc_asset get children
hsc_asset_get descendents
hsc_asset_get parents
hsc_em_FreePointList
hsc_em_GetLastPointChangeTime
hsc_enumlist_destroy
hsc_insert_attrib
hsc_insert_attrib_byindex
hsc_IsError
hsc_IsWarning

hsc_notif send
hsc_param_enum list create
hsc_param_enum_ordinal
hsc_param_enum_string
hsc_param_format
hsc_param_limits
hsc_param_list create
hsc_param_name
hsc_param_number
hsc_param_range
hsc_param_type
hsc_param_value
hsc_param_values
hsc_param_value put
hsc_param_values_put
hsc param value save
hsc_pnttyp list create
hsc_pnttyp name
h